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ORIENTAÇÃO 

Utilização do Software PURPLE PEN 

 

Planear percursos em mapas de Orientação formato PDF  

Percurso formal 

 

Fase (F1) – Instalar e iniciar programa 
1. Aceder a http://purplepen.golde.org/  
2. Fazer download e correr o ficheiro de instalação 
3. Abrir atalho no ambiente 

 
F2 – Criar um evento 

1. Ter disponível um mapa em PDF com escala e equidistância conhecidas; 
2. Opção Create a new event>ok>dar nome ao evento>dar nome ao 

ficheiro>Choose map file>next>definir a escala do mapa em que se vai 
trabalhar>definir a escala de impressão>definir tamanho e orientação da 
folha>escolher local onde ficará guardado o ficheiro com o 
percurso>selecionar padrões IOF do mapa e sinalética (sempre as mais 
atuais)>definir primeiro código a utilizar (habitualmente 31 ou 101)>ok. 

3. O evento está criado – abre-se uma janela com o mapa e barra de 
ferramentas horizontal para seleção de controlos e criação das pernadas, 
gerando-se automaticamente uma sinalética à esquerda. 

 
F3 – Criar um percurso  

1. Menu Course>add course>dar nome ao 
percurso (habitualmente é o 
escalão)>definir tipo de percurso 
(habitualmente normal course = percurso 
formal)>definir escala de impressão para este percurso>definir forma de 
apresentação da sinalética (habitualmente símbolos)>definir o tipo de 
etiqueta de cada controlo no mapa (habitualmente número da 

nota – não esquecer de ir 

gravando periodicamente ao 

longo de todo o processo… 

http://purplepen.golde.org/


sequência)>definir número do primeiro controlo (habitualmente começa no 
1)>ok. 

2. Está criado o percurso, a que corresponde um separador com a respetiva 
designação por cima da sinalética, que foi automaticamente gerada do lado 
esquerdo da janela. 
 

F4 – Planear as pernadas de um percurso 
(estando no separador do respetivo percurso) 

1. Começar pela escolha do local onde se 
entregam os mapas e começa a contagem 
do tempo (partida) 

I. Selecionar ferramenta Add special item na barra de 
ferramentas>opção Time started (habitualmente em Portugal 
escolhe-se a primeira opção entre as 3 que se colocam - o mapa é 
entregue no início do percurso balizado até ao triângulo) 

II. Clicar no local exato onde se pretende fazer a entrega dos mapas. 
2. Passar ao triângulo 

I. Escolher um local para o triângulo 
i. Selecionar ferramenta 

com o ícone do triângulo 
(barra de ferramentas) e 
clicar no local exato 
onde se pretende 
colocar o triângulo. 

3. Definir o finish 
I. Escolher um local para o finish / chegada (habitualmente localiza-se 

na arena) 
i. Selecionar ferramenta com o ícone do finish (barra de 

ferramentas) e clicar no local exato onde se pretende colocar 
o finish. 

4. Planear as pernadas e selecionar os 
pontos 

I. Clicar no triângulo para colocar 
ponto 1 do percurso 

i. Triângulo fica vermelho 
ii. Selecionar ferramenta com o ícone do controlo na barra de 

ferramentas (círculo magenta) e clicar no local exato onde se 
quer colocar o ponto 1 - o controlo 1 é colocado no local e fica 
vermelho 

iii. Repetir II para todos os controlos seguintes até ao finish 
5. Está criado o percurso e, ao mesmo 

tempo, um separador All Controls por 
cima da sinalética, onde vão ficando 
registados todos os pontos 
selecionados no conjunto dos 
percursos criados. 

nota – sempre que necessário usar o 

zoom para ver melhor o mapa 

(encontra-se) no canto inferior direito 

da janela… 

A distância do percurso (em linha reta 

– adequado para a floresta) é 

calculada automaticamente e 

atualizada na respetiva sinalética. 

Ver/recordar características de um 

bom percurso… 

Tratando-se de um percurso balizado 

até ao triângulo, a linha desde a 

partida não é reta ao contrário da 

automaticamente gerada, mas sim 

com a forma real (ver F6). 



 
 
 
 
F5 – Planear um novo percurso 

1. Repetir F3 (é aberto um novo 
separador para o novo percurso, já 
constando o triângulo e o finish, 
que são comuns a todos os 
percursos) 

2. Repetir F4 a partir do n.º 3 (ter em 
conta que, habitualmente, o 
último controlo é comum a todos 
os percursos e que os diferentes 
percursos não devem ter todos o 
mesmo ponto 1) 

 
F6 – Formatar balizados do triângulo e do finish 

1. Clicar sobre o balizado (linha tracejada) da partida para o triângulo (fica 
vermelho – selecionado); 

2. Na barra de ferramentas, selecionar penúltimo item (Add bend) 
3. Clicar sobre o balizado – é inserido um ponto de quebra, que pode ser 

deslocado no espaço, criando uma curva na linha; 
4. Repetir n.º 2 e n.º 3 as vezes que for necessário, até o balizado ter a forma 

desejada; 
5. Replicar n.º 1 a n.º 4 para o balizado do último controlo para o finish. 

 
 
F7 – Reposicionar números e cortar círculos e linhas 

1. Estando num percurso, para 
reposicionar um número: 

I. Clicar sobre número para 
selecionar – fica vermelho; 

II. Arrastar para a posição 
desejada; 

2. Estando num percurso, para cortar 
círculos ou linhas: 

I. Clicar sobre número para 
selecionar – fica vermelho; 

II. Na barra de ferramentas, 
selecionar último item (Add 
gap) – o cursor assume a forma de cruz; 

Notas Menu View  

1. Permite ver os controlos já selecionados 

para outros percursos (all controls) e 

selecionar alguns dos controlos 

existentes para o novo percurso (opção 

All Controls); 

2. Permite ver o mapa com contraste 

reduzido, o que facilita vizualizar o 

percurso (opção Map Intensity). 

 

Dependendo do tamanho de cada percurso, podem definir-se diferentes tamanhos e áreas de 

impressão; ver F8. 

Os números no percurso, os círculos e os segmentos de reta, não devem ocultar informação 

importante no mapa; se necessário, devem ser introduzidos cortes (ver F7) 

Reposicionar os números, se 

necessário, por forma a que: 

• Se vejam bem e não se 

confundam com o fundo; 

• Não induzam em erro ao ficarem 

próximos de outro ponto; 

• Não se sobreponham a 

informação importante do mapa, 

tendo em conta a direção 

previsível de aproximação vindo 

do ponto anterior. 



III. Clicar sobre o ponto onde se quer iniciar o corte, não largar, deslocar 
cursor até ao ponto se pretende terminar o corte, largar – a linha fica 
seccionada. 

 
F8 – Definir tamanho e áreas de impressão 
(para cada percurso em que se queira fazer diferente do definido em F2.2) 

1. Selecionar o separador do percurso que se quer alterar 
2. Menu File>Set print área>This course 
3. É possível: 

I. Manter o tamanho de impressão, mas “deslocar” a área – mover a 
mancha vermelha; 

II. Alterar o tamanho da folha (A3, A4, A5…) 
III. Alterar a posição da folha (deitado ou a alto) 

4. No final – Done. 
 
F9 – Fazer sinalética (descrição dos controlos) 

1. Separador All controls (por cima da sinalética) – abre-se a sinalética para o 
conjunto de todos os pontos do evento; 

2. Clicar sobre a linha do triângulo – fica amarela, o que significa que está 
selecionada; 

3. Clicar coluna D – abre-se uma janela 
com todos os símbolos possíveis para 
esta coluna; selecionar o símbolo 
desejado; 

4. Repetir procedimento para cada uma 
das colunas C, E, F, G e H. 

5. Clicar última linha (chegada) para 
definir o tipo de chegada 
(habitualmente é a primeira opção – balizado até ao finish) 

 
F10 – Arranjos gráficos (estando no separador de um dos percursos) 

1. Integrar sinalética no mapa: 
I. Na barra de ferramentas, selecionar Add Descriptions – o cursor 

assume a forma de cruz; 
II. Levar o cursor ao local onde se pretende integrar a sinalética, 

pressionar botão esquerdo do rato e arrastar cursor (nota – a altura 
de cada linha deve ser entre 5 e 7mm; ver janela com dimensões no 
canto inferior esquerdo; 

III. Para deslocar sinalética para uma nova localização:  
i. Clicar para selecionar; 

ii. Arrastar e largar. 
1. Integrar texto (nome da prova e percurso, escala, equidistância, data e 

qualquer outro texto); 
2. Incluir elementos de imagem (logotipos, seta do norte, etc…); 
3. Incluir outros elementos de criatividade 

 
F7 – Exportar para PDF 

Ao colocar o rato sobre cada símbolo, 

sem clicar, surge o respetivo significado. 

Só devem ser preenchidas as colunas 

efetivamente necessárias e pertinentes. 



1. Menu Export>Mapa e Percurso PDF>Export 
2. Alternativa: 

a. Menu File>Print Courses; 
b. Escolher impressora PDF no canto superior direito (ex: Microsoft print to 

PDF); 
c. Escolher os percursos a converter na janela da direita; 
d. Print. 
 

 

Percurso de Score 

 
Repetir procedimentos do percurso formal até F2; 

F3’ - Criar um percurso  
1. Menu Course>add course>dar nome ao percurso (habitualmente é o 

escalão)>definir tipo de percurso (neste caso, score course)>definir escala de 
impressão para este percurso>definir forma de apresentação da sinalética 
(habitualmente símbolos)>definir o tipo de etiqueta de cada controlo no 
mapa (neste caso sugere-se Code and Score)>definir coluna em que aparece 
a pontuação associada a cada controlo (sugere-se H)>ok. 

2. Está criado o percurso, a que corresponde um separador com a respetiva 
designação por cima da sinalética, que foi automaticamente gerada do lado 
esquerdo da janela. 

 
F4’ - Planear um percurso (estando no separador do respetivo percurso) 

1. Começar pela escolha do local onde se entregam os mapas e começa a 
contagem do tempo (partida) – num percurso de score, convém que seja uma 
zona central relativamente à distribuição de controlos no terreno; 

I. Selecionar ferramenta Add special item na barra de 
ferramentas>opção Time started (habitualmente em Portugal 
escolhe-se a primeira opção entre as 3 que se colocam - o mapa é 
entregue no início do percurso balizado até ao triângulo) 

II. Clicar no local exato onde se pretende fazer a entrega dos mapas. 
2. Passar ao triângulo 

III. Escolher um local para o triângulo 
i. Selecionar ferramenta com o ícone do triângulo (barra de 

ferramentas) e clicar no local exato onde se pretende colocar 
o triângulo. 

3. Definir o finish 
IV. Escolher um local para o finish / chegada (habitualmente localiza-se 

na arena) 
i. Selecionar ferramenta com o ícone do finish (barra de 

ferramentas) e clicar no local exato onde se pretende colocar 
o finish. 

4. Selecionar os pontos 



I. Selecionar ferramenta com o ícone do controlo na barra de 
ferramentas (círculo magenta) e clicar no local exato onde se quer 
colocar o ponto 

II. Repetir para todos os controlos desejados 
5. Está criado o percurso. 

 
 
F5’ – Sinalética (descrição dos controlos) 

1. Para cada controlo: 
a. Clicar coluna D – abre-se uma janela com todos os símbolos possíveis 

para esta coluna; selecionar o símbolo desejado; 
b. Repetir procedimento para cada uma das colunas C, E, F e G; 
c. Clicar coluna H – registar a pontuação que pretende dar-se ao 

controlo respetivo; 
 
 

Percurso de Escolha Livre 

 
Utilizar procedimentos do percurso de score, com as seguintes diferenças: 

F3’’ - Criar um percurso  
1. Menu Course>add course>dar nome ao percurso (habitualmente é o 

escalão)>definir tipo de percurso (neste caso, score course)>definir escala de 
impressão para este percurso>definir forma de apresentação da sinalética 
(habitualmente símbolos)>definir o tipo de etiqueta de cada controlo no 
mapa (neste caso sugere-se Control code)>definir coluna em que aparece a 
pontuação associada a cada controlo (neste caso do not display)>ok. 

2. Está criado o percurso, a que corresponde um separador com a respetiva 
designação por cima da sinalética, que foi automaticamente gerada do lado 
esquerdo da janela. 

 

 

 

Trabalhar com mapas que não de Orientação para atividades informais 

diferentes da Orientação (ex: Peddy-Paper) 

 
Repetir todos os procedimentos utilizados para o percurso formal, com as seguintes 
diferenças: 
 

Pode utilizar um mapa de Orientação ou um mapa não formal, como uma planta turística, 

uma fotografia aérea (ex: GoogleMaps), etc. 



F3’’’ - Criar um percurso 
(…) definir forma de apresentação da sinalética (text)>(…) 

 
F9’’’ – Fazer sinalética (descrição dos controlos) 

1. Menu Event>Costumize decription text; 
2. Na janela que se abre, escolher o primeiro símbolo à esquerda e clicar em 

Change text (à direita); 
3. Na nova janela: 

a. desselecionar Show plural forms; 
b. selecionar a linha com o texto que descreve o símbolo selecionado no 

n.º 2; 
c. escrever o novo 

texto>ok;  
 

 
4. Clicar sobre a linha do triângulo – fica amarela, o que significa que está 

selecionada; 
a. Clicar coluna D – abre-se uma 

janela com todos os símbolos 
possíveis para esta coluna; 
selecionar o símbolo desejado, a 
que corresponderá, na 
sinalética, o texto previamente 
associado; 

5. Repetir este procedimento para cada um dos pontos, incluindo o finish. 
 

 
Exemplos de “sinalética” que podemos obter com este procedimento: 

Ao colocar o rato sobre cada 

símbolo, sem clicar, surge o 

respetivo significado, com o novo 

texto caso tenha sido criado. 

Com os procedimentos referidos em F3 e F9, estamos a introduzir 2 configurações diferentes 

relativamente ao que se faz no percurso formal de Orientação: 

1. Substituir, na sinalética, símbolos por texto; 

2. Substituir o texto padrão associado a cada símbolo, por texto criado por nós, de acordo 

com as necessidades e caraterísticas da atividade que estamos a planear. 

Com estas alterações, podemos planear uma atividade diferente, em que usamos a sinalética para 

transmitir mensagens ou informações, lançar charadas ou fazer perguntas, na lógica, por exemplo 

de um peddy-paper ou de um percurso pedestre. 

Sugere-se que se elaborem previamente todas as questões/informações, e se associe cada 

questão/informação a um símbolo, conforme procedimentos descritos. 

Selecionar a check-box com a opção Show meaning 

below symbolic descriptions. 



 
 
 
 

 
 
 
 

 
 
 

F9’’’a) – Fazer sinalética (descrição dos controlos), adicionando uma linha de texto 
 
É possível, em alternativa ou complemento ao procedimento descrito em F9’’’, adicionar 
uma linha de texto a cada linha da sinalética. 
 

1. Com a sinalética gerada, clicar numa linha da mesma (fica amarela, o que 
significa que está selecionada); 

2. Menu Add>Text Line; 
3. Na janela que se abre, escrever o texto pretendido e ok; 

a. NOTA – é possível editar este texto a qualquer momento, clicando na 
respetiva linha na sinalética. 

 

Exemplos de “sinalética” que podemos obter com este procedimento: 
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